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I N T R O D U C T I O N

Carte adaptateur Bluetooth pour PDA
Merci d’avoir choisi la carte adaptateur Bluetooth pour PDA (la carte adaptateur) équipée de la technologie
Bluetooth de Belkin. Vous pouvez désormais connecter votre PDA à des appareils et autres périphériques
informatiques jusqu’à 10 mètres sans câble. Établissez des connexions ad-hoc entre vos périphériques chez
vous, au bureau ou en déplacement. Imprimez sans câble sur une imprimante équipée de la technologie
Bluetooth sans devoir configurer de réseau.

La technologie sans fil Bluetooth permet des communications rapides, fiables et sûres dans des petits espaces.
Elle vous permet également de synchroniser votre PC de poche avec votre ordinateur de bureau. La
technologie sans fil Bluetooth permet de ne plus utiliser de câble entre vos appareils électroniques, tels que
des ordinateurs de bureau, des imprimantes et des réseaux locaux (LAN).

Avant d’installer votre nouvelle carte adaptateur et de l’utiliser, prenez quelques minutes pour étudier les
termes que vous allez rencontrer dans le document. Vous trouverez un court glossaire page 59 de ce manuel.
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La carte adaptateur est compatible avec la norme Bluetooth version 1.1 et présente les
caractéristiques suivantes :
• Prise en charge de Microsoft® Pocket PC 2000 et PC 2002
• Distance de fonctionnement jusqu’à 10 mètres*
• Connexions point-multipoint
• Prise en charge de débits de données jusqu’à

721 Kbps
• Sécurité intégrée : cryptage et authentification

jusqu’à 128 bits
• Compatibilité avec les PC de poche

*La portée de 10 mètres dépend de l’environnement, du nombre d’utilisateurs et des autres

périphériques sans fil dans votre proximité immédiate.

C A R A C T É R I S T I Q U E S
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S P É C I F I C A T I O N S

Spécifications de la carte adaptateur
Compatibilité Bluetooth : Version 1.1
Interface physique : CompactFlash™ Type II
Fréquence en utilisation : 2,4 à 2,4835 GHz
Puissance en sortie : 0 dBm (1 mW), Classe 2
Sensibilité : -80 dBm à 1E-3 BER
Débit de données : 723/57,6 Kbps
Portée de fonctionnement : Rayon de 10 mètres à l’intérieur
Topologie du réseau : Point-multipoint
Prise en charge de paquet : Paquet à 1/3/5 intervalles de temps
Fonctionnement : Maître/Esclave
Stabilité de fréquence : +/- 10 PPM
Voyant lumineux : Allumé, trafic de données
Type d’antenne : Intégrée
Dimensions : 52 mm (L) x 43 mm (l) x 5 mm (H)
Poids : 25,51 g
Température de fonctionnement : -5 à 55° C
Température de stockage : -33 à 55° C
Humidité : 93 % (sans condensation)
Tension d’alimentation : 3,3 et 5,0 V CC
Courant nominal : 70 mA
Profils de prise en charge : Recherche de services, transfert de fichiers, port série, DUN, LAN, échange d’objet générique, carte de

visite, Push, Pull & Exchange
SE pris en charge : Microsoft Pocket PC 2000 et PC 2002

Ces spécifications sont sujettes à modification sans préavis.
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C O N F I G U R A T I O N  R E Q U I S E

Configuration requise
• Processeur Intel® StrongARM SA-1110 authentique
• Un emplacement CompactFlash Type II libre
• Microsoft Pocket PC 2000 et PC 2002

Contenu du produit
• Carte adaptateur Bluetooth pour PDA
• CD-ROM pour le logiciel d’installation et la documentation
• Manuel de l’utilisateur
• Guide d’installation rapide
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P R O F I L S  P R I S  E N  C H A R G E

Les services pris en charge par votre carte adaptateur sont définis en tant que « Profils ».
Parmi les profils disponibles :
• Accès générique
• Recherche de services
• Port série
• Accès LAN
• Accès réseau à distance
• Échange d’objet générique
• Push objet
• Transfert de fichiers
• Synchronisation
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P R O F I L S  P R I S  E N  C H A R G E  ( S U I T E )

Votre carte adaptateur vous permet d’effectuer les opérations suivantes sans câble :
• Transférer des fichiers
• Accéder à des réseaux à distance
• Vous connecter à des réseau locaux
• Effectuer une session ActiveSync®

• Vous connecter à des ports série
• Échanger des données PIM
• Envoyer ou échanger des cartes de visite

Les fonctions de base de Bluetooth Neighborhood sont notamment :
• Recherche de périphériques
• Recherche de services
• Établissement de liaison avec des périphériques distants
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I N S T A L L A T I O N  D U  L O G I C I E L

Pour installer le logiciel Bluetooth nécessaire à l’utilisation de votre nouvelle carte adaptateur
sur un PC de poche, procédez comme suit :

1. Retirez les accessoires de votre PC de poche.

2. Placez le PC de poche sur son support et établissez une
connexion ActiveSync avec votre ordinateur de bureau
ou votre portable (voir Fig. 1, « Fenêtre ActiveSync »).

3. Insérez le CD d’installation de la carte adaptateur dans
le lecteur de CD-ROM de votre ordinateur de bureau ou
de votre portable.

4. Dans le menu « Start » (Démarrer) du système
Windows de votre ordinateur de base, sélectionnez
« Run » (Exécuter), puis entrez « X:Setup.exe » (où X
représente la lettre de votre lecteur de CD-ROM). Vous
pouvez également rechercher le fichier « Setup.exe »
sur votre CD-ROM. Ensuite, choisissez « OK ».

5. Suivez les instructions qui apparaissent à l’écran.

Fig. 1 — Fenêtre ActiveSync
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I N S T A L L A T I O N  D U  L O G I C I E L  ( S U I T E )

Remarque : Si un message vous demande de
désinstaller des fichiers, suivez les
instructions à l’écran. Une fois
désinstallés, recommencez l’étape 1 de la
procédure.

Fig. 2 — Assistant InstallShield Fig. 3 — Nom du périphérique Bluetooth

Fig. 4 — Téléchargement de l’application terminé
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I N S T A L L A T I O N  D U  L O G I C I E L  ( S U I T E )

6. Si vous ne parvenez pas à charger l’application,
rétablissez les paramètres d’usine du PC de poche.
Reportez-vous au guide de l’utilisateur de votre PC
de poche pour obtenir des informations
supplémentaires sur cette opération.

Remarque : Assurez-vous que votre ordinateur de bureau ou
portable et votre PC de poche ont terminé toutes les
opérations avant de quitter le programme d’installation.

7. Après avoir installé le logiciel, retirez le PC de poche
de son support et effectuez un redémarrage système
en insérant le stylet dans l’orifice situé au bas du PC
de poche. Reportez-vous au guide de l’utilisateur de
votre PC de poche pour obtenir des informations
supplémentaires sur cette opération.

Fig. 5 — Assistant InstallShield terminé
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I N S T A L L A T I O N  D E  L A  C A R T E  A D A P T A T E U R

Insérez la carte adaptateur dans le PC de poche. L’icône Radio
Bluetooth doit apparaître au bas de l’écran « Today »
(Aujourd’hui). Le voyant lumineux en haut de la carte
adaptateur doit clignoter.

1. Au départ, l’icône
Radio Bluetooth est
sombre lorsque le PC
de poche est inséré
dans le pack
d’expansion Compact
Flash et devient plus
claire lorsque le PC
reconnaît le logiciel.

2. Si vous ne voyez
aucune nouvelle icône,
effectuez de nouveau
une réinitialisation du PC
de poche.

Fig. 7 — Insertion de la carte adaptateur

Fig. 6 — Icône radio Bluetooth
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P R É S E N T A T I O N  D U  L O G I C I E L

Lancement de l’application
Vous pouvez lancer l’application Bluetooth à partir de l’écran « Today » (Aujourd’hui) du PC de poche.
Sélectionnez « Bluetooth Manager » (Gestionnaire Bluetooth) depuis le menu « Start » (Démarrer) (voir Fig. 8
ci-dessous, « Lancement du gestionnaire Bluetooth à partir du menu Démarrer ») ou du menu Radio Bluetooth

(voir Fig. 9, « Lancement du gestionnaire
Bluetooth à partir de l’icône du menu Radio
Bluetooth »). Pour accéder au menu Radio
Bluetooth, sélectionnez l’icône Radio
Bluetooth au bas de l’écran « Today »
(Aujourd’hui).

Fig. 8 — LANCEMENT DU GESTIONNAIRE
BLUETOOTH À PARTIR DU MENU DÉMARRER

Fig. 9 — LANCEMENT DU GESTIONNAIRE
BLUETOOTH À PARTIR DE L’ICÔNE DU MENU
RADIO BLUETOOTH
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P R É S E N T A T I O N  D U  L O G I C I E L  ( S U I T E )

Si aucun périphérique n’est enregistré sur votre PC de poche, un message vous demande de rechercher les
périphériques Bluetooth (voir Fig. 10, « Première invite de recherche »).

Choisissez « Yes » (Oui) pour afficher l’écran de recherche. La carte adaptateur recherche alors les
périphériques Bluetooth dans la zone.

Choisissez « No » (Non) pour passer à la fenêtre principale sans effectuer de recherche.

Une fois la recherche terminée, tous les
périphériques trouvés s’affichent à l’écran (voir
Fig. 11, « Écran de recherche »).

Fig. 10 — PREMIÈRE INVITE DE RECHERCHE Fig. 11 — ÉCRAN DE RECHERCHE
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P R É S E N T A T I O N  D U  L O G I C I E L  ( S U I T E )

Vous pouvez maintenant affecter ces périphériques à un « Groupe de périphériques ». Pour plus
d’informations sur les groupes de périphériques, reportez-vous à la section « Groupes de périphériques ».

1. Pour sélectionner les périphériques que vous souhaitez conserver, cochez la case correspondante.

2. Sélectionnez « Save » (Enregistrer). L’écran « Device Groups » (Groupes de périphériques) apparaît (voir
Fig. 12, « Groupes de périphériques »).

Remarque : Seuls les groupes « All Devices » (Tous les périphériques), « Home »
(Domicile) et « Work » (Travail) apparaissent tant que vous n’ajoutez pas d’autres
groupes à la liste (reportez-vous à la section « Modification des groupes »). Le
groupe « All Devices » (Tous les périphériques) est automatiquement sélectionné et
ombré. Vous ne pouvez pas le désélectionner.

3. Choisissez « OK » pour enregistrer les périphériques sélectionnés dans les
groupes sélectionnés et revenir dans l’écran de recherche.

4. Répétez cette procédure pour tout périphérique ou groupe supplémentaire.

5. Sélectionnez « OK » pour revenir dans la fenêtre principale.

Fig. 12 — GROUPES DE PÉRIPHÉRIQUES
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P R É S E N T A T I O N  D U  L O G I C I E L  ( S U I T E )

Fenêtre principale
Après cette session de recherche de périphériques, la fenêtre
« principale » apparaît (voir Fig. 13, « Commandes de la fenêtre
principale »). Elle affiche les périphériques Bluetooth enregistrés.
Après la première recherche, la fenêtre affiche le groupe « All
Devices » (Tous les périphériques).

• La fenêtre principale n’affiche PAS nécessairement tous les
périphériques dans la zone de portée du périphérique de
l’utilisateur au moment de l’affichage. Il est possible qu’AUCUN
des périphériques affichés ne soit à portée. L’écran donne une
indication des périphériques qui se trouvent à portée ou en-
dehors.

Fig. 13 — COMMANDES DE LA FENÊTRE
PRINCIPALE
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P R É S E N T A T I O N  D U  L O G I C I E L  ( S U I T E )

Menu déroulant « Device Group » (Groupe de périphériques)
Le menu déroulant « Device Group » (Groupe de périphériques) vous permet d’afficher les périphériques
trouvés dans un groupe particulier ou dans tous les groupes (« All Devices »). Ce menu déroulant comporte
également des commandes permettant d’ajouter, de modifier ou de supprimer un groupe (reportez-vous à la
section « Modification des groupes »).

« Device List » (Liste de périphériques)
L’écran « Device List » (Liste de périphériques) affiche les périphériques (d’autres PC de poche, des portables,
etc., par exemple) reconnus par votre PC de poche. La disponibilité de ces périphériques apparaît dans la
colonne d’état du mode d’affichage ou indiquée par la présence de l’icône.

Menu « View » (Affichage)
Le menu « View » (Affichage) vous permet de passer du mode d’affichage « Icons » (Icônes) à « List » (Liste).
Ce menu vous permet également d’actualiser l’état des périphériques affichés (reportez-vous à la section
« Affichage des périphériques »).
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P R É S E N T A T I O N  D U  L O G I C I E L  ( S U I T E )

Menu « Tools » (Outils)
Le menu « Tools » (Outils) permet l’accès à des boîtes de dialogue de paramétrage des groupes (reportez-
vous à la section « Paramètres de groupes ») et de diagnostics du système (reportez-vous à la section
« Diagnostic du système »).

Search (Rechercher)
La commande « Search » (Rechercher) fait
apparaître l’écran « Search » (Recherche)
(reportez-vous à la section « Écran
Recherche »).

Icône Radio Bluetooth
Une fois l’application Bluetooth démarrée, vous
pouvez voir l’icône Radio Bluetooth au bas de
la fenêtre « Today » (Aujourd’hui) (voir
Fig. 14, « Écran Aujourd’hui ») ou au bas de la
fenêtre principale « Bluetooth Application »
(Application Bluetooth) (voir Fig. 15, « Fenêtre
d’application Bluetooth »).

Fig. 14 — ÉCRAN AUJOURD’HUI Fig. 15 — FENÊTRE D’APPLICATION
Bluetooth
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P R É S E N T A T I O N  D U  L O G I C I E L  ( S U I T E )

Depuis la partie inférieure de l’écran « Today » (Aujourd’hui) vous pouvez :
1. Activer ou désactiver la radio : sélectionnez cette option pour activer ou désactiver la radio.

2. Lancer l’application « Bluetooth Manager » (Gestionnaire Bluetooth).

3. Lancer une session sans fil ActiveSync (reportez-vous à la section « Effectuer une session ActiveSync »).

4. Afficher l’état actuel de la radio et des connexions (voir Fig. 16, « État de
Bluetooth »).

Sélectionnez et maintenez tout périphérique présent dans la liste
des connexions en cours de la fenêtre « Current Status » (État
actuel) pour ouvrir un menu qui vous permet de fermer la
connexion et d’obtenir des informations sur la version de
« Bluetooth Manager » (Gestionnaire Bluetooth).

Fig. 16 — ÉTAT DE BLUETOOTH
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R E C H E R C H E  D E  P É R I P H É R I Q U E S

Écran « Search » (Recherche)
L’écran « Search » (Recherche) (voir Fig. 17, « Écran de Recherche ») vous permet de rechercher des
périphériques et de les affecter à des groupes. Pour ouvrir l’écran « Search » (Recherche), sélectionnez
« Search » (Rechercher) au bas de la fenêtre principale. La carte adaptateur commence immédiatement la
recherche des périphériques Bluetooth. Une fois la recherche terminée, l’écran affiche la liste des périphériques.

« Device List » (Liste de périphériques)
Présentée sous la forme d’un tableau, cette liste affiche les périphériques
trouvés pendant la recherche. Elle peut être triée en fonction du « Device
Name » (Nom du périphérique) ou du « Type ». Il vous suffit pour cela de
sélectionner l’en-tête approprié.

1. Le nom du périphérique apparaît à gauche.

2. Le type du périphérique apparaît à droite.

3. Une case à cocher est fournie afin de sélectionner un ou plusieurs
périphériques à enregistrer dans des groupes.

4. La colonne « New » (Nouveau) est indiquée par un astérisque « * » si le
périphérique trouvé ne fait pas encore partie de votre base de données.

Fig. 17 — Écran de recherche
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R E C H E R C H E  D E  P É R I P H É R I Q U E S  ( S U I T E )

Bouton « Search » (Rechercher)
Lance la recherche de périphériques (reportez-vous à la section « Recherche de périphériques »).

Bouton « Save » (Enregistrer)
Permet d’enregistrer les périphériques dans des groupes (reportez-vous à la section « Enregistrement des
périphériques »).

Bouton « Filter » (Filtrer)
Affiche l’écran de filtre de recherche (voir Fig. 18, « Filtre de recherche »).
Permet d’affiner votre recherche de certains périphériques. L’option « Find all
devices » (Rechercher tous les périphériques) est sélectionnée par défaut. Cet
écran vous permet également de spécifier la durée de la recherche.

Remarque : Si vous ne cochez pas la case « Stop searching after » (Arrêter de
chercher après), la recherche se poursuivra jusqu’à ce que vous l’interrompiez en
choisissant « Stop ».

Fig. 18 — Filtre de recherche
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R E C H E R C H E  D E  P É R I P H É R I Q U E S  ( S U I T E )

Ligne de l’état de la recherche
Chaîne de texte située au bas de l’écran de recherche qui affiche l’état de la recherche. Cette ligne d’état vous
indique également le nombre de périphériques trouvés lors de la recherche.

Recherche de périphériques
Votre première recherche a eu lieu lorsque vous avez lancé l’application (reportez-vous à la section
« Démarrage »). Il est toujours possible d’effectuer une nouvelle recherche
de périphériques Bluetooth. Cette recherche n’a aucun effet sur les
périphériques déjà enregistrés dans l’un de vos groupes.

Au bas de la fenêtre de principale, sélectionnez « Search » (Rechercher).
L’écran « Search » (Recherche) apparaît. La carte adaptateur commence la
recherche des périphériques Bluetooth dans la zone. Ces périphériques
apparaissent à l’écran dans l’ordre où ils sont trouvés (voir Fig. 19,
« Recherche des périphériques Bluetooth »).

Fig. 19 — Recherche des périphériques
Bluetooth
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R E C H E R C H E  D E  P É R I P H É R I Q U E S  ( S U I T E )

Le bouton « Search » (Rechercher) se transforme en « Stop » (Arrêter) au cours de la recherche, puis redevient
« Search » (Rechercher) une fois l’opération terminée (dépassement de délai) ou lorsque vous choisissez
« Stop » (Arrêter).

Enregistrement des périphériques
Une fois un périphérique trouvé et si vous décidez de l’enregistrer pour une utilisation ultérieure, vous devez

l’enregistrer dans un groupe de périphériques. La procédure est identique à
celle employée lorsque vous avez effectué la première recherche, sauf que
vous disposez peut-être de groupes de périphériques supplémentaires.

1. Dans l’écran « Search » (Recherche), sélectionnez les périphériques que
vous souhaitez conserver en cochant les cases correspondantes.

2. Sélectionnez « Save » (Enregistrer). L’écran « Device Groups » (Groupes de
périphériques) apparaît (voir Fig. 20, « Groupes de périphériques »).

Fig. 20 — Groupes de périphériques
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R E C H E R C H E  D E  P É R I P H É R I Q U E S  ( S U I T E )

3. Cochez la case en regard des groupes dans lesquels vous souhaitez enregistrer ces périphériques.

a) Vous pouvez cocher un ou plusieurs groupes. Vous pouvez modifier les groupes avant d’effectuer la
sélection en choisissant le bouton « Add Group » (Ajouter un groupe) (reportez-vous à la section
« Modification des groupes »).

4. Sélectionnez « OK » pour enregistrer les périphériques dans les groupes indiqués et repasser dans l’écran
« Search » (Recherche).

5. Répétez cette opération pour les autres périphériques.

a) Lorsque vous enregistrez un périphérique dans un groupe, il est également enregistré dans le groupe
« All Devices » (Tous les périphériques).
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R E C H E R C H E  D E  P É R I P H É R I Q U E S  ( S U I T E )

Boîte de dialogue « Device Information » (Informations sur le périphérique)
Vous pouvez accéder à la boîte de dialogue « Device Information » (Informations sur le périphérique) à partir
de la fenêtre principale. Pour cela, cliquez sur l’icône d’un périphérique (voir Fig. 21, « Informations sur le
périphérique »).

Nom du périphérique Nom attribué par le propriétaire du périphérique sélectionné.

Adresse de périphérique Adresse Bluetooth unique utilisée pour l’identification du périphérique.

Type de périphérique Permet d’identifier le type de périphérique (par exemple, PDA, téléphone
cellulaire, etc.).

Périphérique lié Affiche « Yes » (Oui) si un lien a été établi. La liaison autorise les périphériques
à passer outre l’autorisation et l’authentification. Une liaison peut être créée ou
rompue via le menu « Actions » situé au bas de l’écran « Device Information »
(Informations sur le périphérique).

« Last Seen » (Dernière recherche) Indique la date et l’heure de la précédente recherche du
périphérique près du vôtre.



Case « ActiveSync Partner » (Partenaire ActiveSync) Cette fonction est uniquement active pour les ordinateurs
portables et de bureau. Cochez cette case pour indiquer que vous souhaitez
employer ce périphérique comme partenaire ActiveSync.

« Show Device Groups » (Afficher les groupes de périphériques) Sélectionnez cette option pour consulter ou
spécifier les groupes auxquels ce périphérique
appartient (reportez-vous à la section
« Déplacement et suppression de
périphériques » page 40).

Menu Actions Vous permet de lancer une action avec le
périphérique sélectionné (l’envoi d’une carte de
visite, par exemple). (Reportez-vous à la section
« Communication avec d’autres
périphériques » page 29).

Fig. 21 — Informations sur le périphérique
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Menu « View » (Affichage)
Les périphériques peuvent être affichés selon deux formats différents, à savoir icônes et liste. Le menu
« View » (Affichage) (voir Fig. 22, « Menu « View » (mode icône) vous permet de sélectionner ces modes. Il
vous permet également d’actualiser l’écran.

• Le mode icône voir Fig. 22, « Menu Affichage (mode Icône) ») vous propose une représentation
graphique du périphérique (ordinateur, point d’accès, téléphone cellulaire,
etc.). Le nom du périphérique affecté par le propriétaire du périphérique
apparaît en-dessous de l’icône.

R E C H E R C H E  D E  P É R I P H É R I Q U E S  ( S U I T E )

Fig. 22 —Menu Affichage (mode Icône)
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• Le mode liste (voir Fig. 23, « Mode liste ») fournit les même informations que le mode Icône, mais sous
forme de tableau. La colonne de gauche affiche le nom et le type du périphérique. La colonne de droite
vous indique l’état actuel du périphérique (connecté, libre, non disponible).

• L’actualisation permet de mettre à jour l’état et la disponibilité de chaque périphérique affiché.

Communication avec d’autres périphériques
Une fois que vous avez établi un contact avec un périphérique, vous pouvez
utiliser la radio installée pour échanger des données.

Vous pouvez :
1. Envoyer un fichier.
2. Envoyer ou échanger des contacts, des calendriers et des tâches.
3. Effectuer une session ActiveSync.
4. Vous connecter pour un accès distant ou LAN.
5. Vous connecter au port série.
6. Créer ou supprimer des liaisons.

Vous pouvez établir des communications à partir de la fenêtre principale ou de
la boîte de dialogue « Device Information » (Informations sur le périphérique).

Fig. 24 — Communication avec d’autres
périphériques
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À partir de la fenêtre principale, cliquez sur l’icône du périphérique avec lequel vous souhaitez communiquer
et maintenez-la sélectionnée. La liste des services pris en charge par le périphérique sélectionné apparaît (voir
Fig. 24, « Communication avec d’autres périphériques »).

Ou, depuis la boîte de dialogue « Device Information » (Informations sur le périphérique), sélectionnez le
menu « Actions » (voir Fig. 25, « Menu Actions »). Les services seront uniquement affichés si le périphérique
sélectionné peut être trouvé.

« Send File » (Envoyer un fichier)
Permet d’envoyer un fichier à un autre
périphérique.

1. Recherchez les services disponibles du
périphérique auquel vous souhaitez
envoyer un fichier.

2. Dans la fenêtre principale, cliquez sur
l’icône du périphérique et maintenez la
sélection. Dans le boîte de dialogue
« Device Information » (Informations sur
le périphérique), effectuez la sélection via
le menu « Actions ».

R E C H E R C H E  D E  P É R I P H É R I Q U E S  ( S U I T E )

Fig. 26 — Envoi d’un fichierFig. 25 — Menu Actions
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3. Sélectionnez « Send File » (Envoyer un fichier). L’écran « Send a File » (Envoi d’un fichier) apparaît
(voir Fig. 26, « Envoi d’un fichier »).

4. Spécifiez le fichier à envoyer en entrant son emplacement et son nom dans la fenêtre ou en
sélectionnant le fichier à partir du menu « Browse… » (Parcourir).

5. Cliquez sur « Send » (Envoyer) pour transférer le fichier ou sur « Cancel » (Annuler) pour
abandonner l’opération. La progression
du transfert s’affiche (voir Fig. 27, « Envoi
d’un fichier (Transmission) »). Le bouton
d’envoi est ombré. Il est uniquement
activé lorsque l’utilisateur sélectionne le
fichier à envoyer.

R E C H E R C H E  D E  P É R I P H É R I Q U E S  ( S U I T E )

Fig. 27 — Envoi d’un fichier
(Transmission)

Fig. 28 — Veuillez sélectionner un contact
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« Send Business Cards » (Envoyer des cartes de visite)
Vous permet d’envoyer votre carte de visite à un autre périphérique.

Dans la fenêtre principale :
1. Recherchez les services disponibles du périphérique auquel vous souhaitez envoyer une carte de visite.

Dans la fenêtre principale, cliquez sur l’icône du périphérique et maintenez la sélection. Dans le boîte de
dialogue « Device Information » (Informations sur le périphérique), effectuez
la sélection via le menu « Actions ».

2. Sélectionnez « Send Business Card » (Envoyer une carte de visite). Si vous
n’avez pas configuré vos informations de carte de visite, un message vous
demande de sélectionner un nom de contact dans votre base de données
(voir Fig. 28, « Veuillez sélectionner un contact »). Sélectionnez un contact
et cliquez sur « OK » ou sur « Cancel » (Annuler) pour définir vos
informations.

3. Une fois le contact sélectionné pour le transfert de la carte de visite, il
restera le contact par défaut tant que vous n’en changerez pas.

4. La réussite ou l’échec du transfert s’affiche.

R E C H E R C H E  D E  P É R I P H É R I Q U E S  ( S U I T E )

Fig. 29 — Boîte de dialogue Contacts
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Dans la boîte de dialogue « Contacts » :
Il est également possible d’envoyer des cartes de visite directement depuis la liste Contacts.

Dans le menu « Start » (Démarrer), sélectionnez « Contacts » :
1. Cliquez sur l’élément de « Contacts » que vous voulez envoyer à un autre périphérique et maintenez-le

sélectionné (voir Fig. 29, « Boîte de dialogue Contacts ») ou sélectionnez un élément de contact et
choisissez « Tools » (Outils) (voir Fig. 30, « Menu Outils des contacts »).

2. Sélectionnez « Send Via Bluetooth » (Envoyer via Bluetooth). Une boîte de
dialogue de recherche apparaît à l’écran.

a) Le bouton « Detail » (Détail) de la boîte de dialogue « Search »
(Recherche) affiche les détails de la transaction.

b) Le bouton « Refresh » (Actualiser) de la boîte de dialogue « Search »
(Recherche) actualise la liste des périphériques.

3. Sélectionnez le périphérique vers lequel vous souhaitez envoyer la carte
de visite et choisissez « Send » (Envoyer).

Remarque : La réussite ou l’échec du transfert s’affiche.

Remarque : La procédure ci-dessus est également valable pour « Calendar »
(Calendrier) et « Tasks » (Tâches).

R E C H E R C H E  D E  P É R I P H É R I Q U E S  ( S U I T E )

Fig. 30 — Menu Outils des contacts
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« Exchange Business Cards » (Échanger des cartes de visite)
Vous permet d’échanger des cartes de visite avec un autre périphérique. Cette opération fonctionne de la
même façon que lorsque vous envoyez votre carte de visite sauf que, si elles sont disponible, vous recevrez
également les informations de l’autre périphérique directement dans votre base de données de contacts.

« Connect to Serial Port » (Se connecter au port série)
Vous permet de vous connecter au port série virtuel Bluetooth d’un autre
périphérique afin de vous servir de certains matériels et applications.

R E C H E R C H E  D E  P É R I P H É R I Q U E S  ( S U I T E )

Fig. 31 — Informations d’accès à distance
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« Connect for Dial-Up Access » (Se connecter pour un accès à distance)
1. Sur Pocket PC 2002, cet élément de menu est appelé « Set as Internet Dial-Up connection » (Définir

comme connexion distante à Internet).

2. Vous permet de vous connecter sans fil à des téléphones cellulaires et des modems équipés de la
technologie Bluetooth. Un message vous demandera d’abord de choisir ou de créer une connexion pour
accès distant en indiquant les informations de numérotation élémentaires
(voir Fig. 31, « Informations d’accès à distance »). Une fois connecté à un
périphérique disposant des possibilités d’accès distant, des informations
supplémentaires pourront vous être demandées. Reportez-vous au guide
de l’utilisateur de votre PC de poche pour obtenir des informations
supplémentaires sur cette opération.

R E C H E R C H E  D E  P É R I P H É R I Q U E S  ( S U I T E )

Fig. 32 — Partenaire ActiveSync
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« Connect for LAN Access » (Se connecter pour un accès au LAN)
1. Sur Pocket PC 2002, cet élément de menu est appelé « Set as Internet LAN connection » (Définir comme

connexion LAN à Internet).

2. Vous permet de vous connecter aux périphériques Bluetooth qui font déjà partie d’un réseau local (LAN).
Une fois connecté, vous pourrez participer au LAN pour accéder à des services comme Internet.

« Perform an ActiveSync Session » (Effectuer une session ActiveSync)
Vous permet de vous connecter (et mettre automatiquement à jour) les informations avec un périphériques
Bluetooth désigné comme partenaire ActiveSync.

Configuration de l’ordinateur hôte pour Active Sync
Seul un ordinateur portable ou de bureau (PC hôte) peut être désigné comme partenaire ActiveSync.

1. En vous servant de la connexion série ou USB, établissez manuellement un partenariat ActiveSync comme
décrit dans le guide de l’utilisateur de votre PC de poche.

Remarque : Vous pouvez établir un partenariat avec plusieurs périphériques. Toutefois, votre périphérique lancera une
fonction ActiveSync avec le premier périphérique en partenariat rencontré.
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2. Exécutez l’utilitaire de configuration Bluetooth sur le PC hôte afin de déterminer quel port COM est
configuré pour le service série local. Reportez-vous à la documentation de l’utilisateur Bluetooth fournie
avec votre PC hôte pour obtenir des informations sur l’exécution de l’utilitaire de configuration.

3. Ouvrez la fenêtre ActiveSync sur le PC hôte. Sélectionnez « File/Connection Settings… »
(Fichier/Paramètres de connexion) et configurez-le pour surveiller uniquement le port COM identifié au
cours de l’étape 2 ci-dessus. Désactivez l’USB et Ethernet.

« Wireless ActiveSync » (ActiveSync sans fil) :
1. Recherchez et enregistrez le PC hôte dans un ou plusieurs groupes.

2. Cliquez sur le PC hôte ActiveSync pour afficher « Device Information »
(Informations sur le périphérique), puis cochez la case « ActiveSync
Partner » (Partenaire ActiveSync) (voir Fig. 32, « Partenaire ActiveSync »).

3. Lancez ActiveSync via l’icône Radio Bluetooth située au bas de l’écran
« Today » (Auhourd’hui) (voir Fig. 6 page 13).

4. Suivez les instructions qui apparaissent à l’écran.

R E C H E R C H E  D E  P É R I P H É R I Q U E S  ( S U I T E )

Fig. 33 — Code PIN demandé
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« Create bond with this device » (Créer une liaison avec ce périphérique) :
Disponible uniquement dans le menu « Actions », cette fonction vous permet d’établir une liaison avec un
autre périphérique afin d’établir un échange de données ininterrompu.

1. Affichez la boîte de dialogue « Device Information » (Informations sur le périphérique) sur l’appareil avec
lequel vous souhaitez établir la liaison.

2. Sélectionnez « Create bond with this device » (Créer une liaison avec ce
périphérique) dans le menu « Actions ». Un écran apparaît. Il vous invite à
entrer un code PIN (voir Fig. 33, « Code PIN demandé »).

3. Entrez le code PIN que vous et le propriétaire du périphérique sélectionné
avez choisi.

4. Sélectionnez « OK ». Un message demandera au propriétaire du
périphérique sélectionné d’entrer le même code PIN.

5. Un écran d’état apparaît. Il indique l’établissement de la liaison.

R E C H E R C H E  D E  P É R I P H É R I Q U E S  ( S U I T E )

Fig. 34 — Modification des groupes
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« Remove bond with device » (Supprimer la liaison avec le périphérique) :
Disponible uniquement dans le menu « Actions », cette fonction vous permet de supprimer une liaison.

1. Affichez la boîte de dialogue « Device Information » (Informations sur le périphérique) sur l’appareil
duquel vous souhaitez supprimer la liaison.

2. Sélectionnez « Remove bond with this device » (Supprimer la liaison avec ce périphérique) dans le menu
« Actions ».

« Remove this device » (Supprimer ce périphérique) :
Vous permet de supprimer un périphérique de votre base de données.

1. Affichez la boîte de dialogue « Device Information » (Informations sur le périphérique) sur l’appareil que
vous souhaitez supprimer.

2. Sélectionnez « Remove this device » (Supprimer ce périphérique) dans le menu « Actions ». Un message
d’avertissement vous demande de confirmer l’action. Vous repassez dans la fenêtre principale. Le
périphérique sélectionné ne figure plus dans vos groupes.
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Déplacement et suppression de périphériques
Vous pouvez déplacer un périphérique entre des groupes ou en supprimer un d’un groupe à l’exception de
« All Devices » (Tous les périphériques). Vous pouvez uniquement supprimer un périphérique du groupe « All
Devices » (Tous les périphériques) en le supprimant de votre base de données.

1. Activez le périphérique pour afficher la fenêtre « Device Information » (Informations sur le périphérique).

2. Cliquez sur le bouton « Show Device Groups » (Afficher les groupes de périphériques) pour afficher l’écran
« Device Groups » (Groupes de périphériques).

3. Cochez les groupes dans lesquels vous souhaitez voir figurer le périphérique et désélectionnez ceux dans
lesquels vous ne voulez pas qu’il apparaisse.
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Utilisation des groupes de périphériques
Trois groupes vides appelés « All Devices » (Tous les périphériques), « Home » (Domicile) et « Work » (Travail)
sont fournis lorsque vous installez le logiciel Bluetooth. Tous les périphériques Bluetooth trouvés sont stockés
dans le groupe « All Devices » (Tous les périphériques). Ce groupe ne peut être ni renommé, ni supprimé.

Modification des groupes
Il est possible d’ajouter, de renommer ou de
supprimer des éléments de votre liste de groupes.
Dans la fenêtre principale, sélectionnez
« Add/Rename/Delete » (Ajouter/Renommer/
Supprimer) dans le menu déroulant « Group List »
(Liste des groupes) (voir Fig. 34, « Modification
des groupes »). Ou, dans l’écran « Device
Information » (Informations sur le périphérique),
cliquez sur le bouton « Show Device Groups »
(Afficher les groupes de périphériques), puis sur le
bouton « Add Group » (Ajouter un groupe).
L’écran « Edit Device Groups » (Modification des
groupes de périphériques) apparaît (voir Fig. 35,
« Modification des groupes de périphériques »). Il
affiche tous les groupes actuels.

G R O U P E S  D E  P É R I P H É R I Q U E S

Fig. 35 — Modification des groupes de
périphériques

Fig. 36 — Sélection des paramètres de
<groupe>
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Pour ajouter un groupe :
1. Cliquez sur le bouton « Add » (Ajouter). Un autre groupe appelé « New Group » (Nouveau groupe) est

ajouté à la liste.
2. Sélectionnez le texte « New Group », puis entrez le nom que vous avez choisi.
3. Sélectionnez « Enter » (Entrée).

Pour renommer un groupe :
1. Sélectionnez le texte du groupe à renommer, puis cliquez sur le bouton « Rename » (Renommer).
2. Entrez le nom choisi.
3. Sélectionnez « Enter » (Entrée).

Pour supprimer un groupe :
1. Sélectionnez le groupe à supprimer.
2. Cliquez sur le bouton « Delete » (Supprimer). Un message d’avertissement vous demande de confirmer

l’action.
3. Cliquez sur « Yes » (Oui) pour supprimer le groupe ou sur « No » (Non) pour abandonner.
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Paramètres de groupes
Pour accéder à « Group Settings » (Paramètres de groupes), sélectionnez l’option « Settings for <group> »
(Paramètres de <groupe)> dans le menu « Tools » (Outils) de la fenêtre principale (voir Fig. 36, « Sélection
des paramètres de <groupe> »).

Ces paramètres fournissent au groupe certaines informations concernant votre périphérique. Ils spécifient
également l’interaction avec le reste du
groupe. Les paramètres du groupe sont
répartis entre six onglets (voir Fig. 37,
« Onglet Général »). Vous pouvez changer
le groupe que vous modifiez à partir de
n’importe quel onglet. Le fait de changer
de groupe ou d’onglet enregistre
automatiquement les données.

G R O U P E S  D E  P É R I P H É R I Q U E S  ( S U I T E )

Fig. 37 — Onglet « General » (Général) Fig. 38 — Choix des périphériques
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Onglet « General » (Général)

« Device Name » (Nom du périphérique)
Il s’agit du nom que les autres utilisateurs de périphériques Bluetooth voient lorsqu’ils trouvent le votre.

« Default Passkey » (Mot de passe par défaut) (vide par défaut)
Utilisé pour authentifier les connexions demandées par d’autres périphériques pour des transactions qui
nécessitent un mot de passe (reportez-vous aux autres onglets de service pour connaître les exigences pour le
mot de passe). L’autre utilisateur doit connaître votre mot de passe pour effectuer la transaction. Si ce champ
est vide, vous devrez entrer un mot de passe chaque fois qu’un est requis.

« Delete Inactive Devices » (Supprimer les périphériques inactifs) (uniquement dans « All
Devices »)
Définit la durée de présence d’un périphérique dans le groupe entre deux recherches de périphériques. Vous
pouvez spécifier le nombre de jours utilisé par le système (30 jours par défaut). Si la case n’est pas cochée, les
périphériques ne sont jamais automatiquement supprimés du groupe.

C O N F I G U R A T I O N  E T  P A R A M È T R E S
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Onglet « Connections » (Connexions)

« Let other devices see me » (Autoriser les autres périphériques à me voir) (sélectionné par
défaut)
Cochez cette case pour permettre aux autres périphériques de localiser le votre au cours de la recherche. Ceci
n’empêchera pas les périphériques qui vous ont déjà trouvé d’effectuer une transaction puisqu’ils connaissent
déjà votre adresse Bluetooth.

« Let other devices connect to me »
(Autoriser les autres périphériques à se
connecter à moi) (sélectionné par défaut)
Cochez cette case pour permettre aux autres
périphériques de se connecter et d’effectuer
des transactions. Si vous ne la cochez pas,
aucun périphérique ne pourra établir de
connexion avec vous. Cette case n’a aucun
effet sur les demandes de connexion sortantes.
Utilisez la boîte de dialogue « Choose
devices… » (Choix des périphériques) (voir
Fig. 38, « Choix des périphériques ») pour
spécifier le type de périphériques autorisés à
se connecter avec vous.

C O N F I G U R A T I O N  E T  P A R A M È T R E S  ( S U I T E )

Fig. 38b — Boîte de dialogue « Choose
Devices » (Choix des périphériques)

Fig. 39 — Onglet « File Sharing »
(Partage de fichiers)
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« Transmission power for this group » (Puissance de transmission pour ce groupe)
Permet de choisir le niveau de transmission utilisé lorsque ce groupe est sélectionné. La sélection de ce niveau
de puissance détermine la portée de transmission (et, par conséquent, la consommation électrique) de votre
périphérique.

Onglet « File Sharing » (Partage de fichiers)

« Let other devices use this service » (Autoriser les autres
périphériques à utiliser ce service) (sélectionné par défaut)
Cochez cette case pour permettre aux autres périphériques de se connecter
pour partager des fichiers. Si la case n’est pas cochée, vous pouvez toujours
vous connecter à d’autres périphériques et leur envoyer des fichiers (voir
Fig. 39, « Onglet “File Sharing” (Partage de fichiers) »).

« Authorization required » (Autorisation requise) (sélectionné par défaut)
Cochez cette case si vous voulez filtrer les périphériques non liés avant
d’autoriser une transaction. Si elle est cochée, un message vous demande
d’accepter (Accept) ou de refuser (Reject) les transactions avec les
périphériques non liés (voir Fig. 40, « Boîte de dialogue “Authorization”
(Autorisation) »).

C O N F I G U R A T I O N  E T  P A R A M È T R E S  ( S U I T E )

Fig. 40 — Boîte de dialogue « Authorization »
(Autorisation)
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« Passkey is required » (Mot de passe requis) (désélectionné par défaut)
Cochez cette case pour demander l’authentification pour le partage de fichiers. Si elle n’est pas cochée, un
message vous demande d’accepter (Accept) ou de refuser (Reject) les transactions avec les périphériques non
liés (voir Fig. 41, « Demande de mot de passe »). Les périphériques non liés devront fournir un mot de passe
correspondant.

« Encryption is required » (Cryptage
requis)
Fonction activée uniquement lorsque vous
cochez l’option « Passkey is required » (Mot
de passe requis). Cochez cette case pour
activer le cryptage des données lors de la
transmission des données.

« Shared Directory » (Répertoire
partagé)
Affiche le nom et le chemin d’accès au
dossier utilisé pour stocker les fichiers reçus
d’autres périphériques.

C O N F I G U R A T I O N  E T  P A R A M È T R E S  ( S U I T E )

Fig. 41 — Demande de mot de passe Fig. 42 — Onglet « PIM Objects » (Objets
PIM)
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Onglet « PIM Objects » (Objets PIM)

« Let other devices use this service » (Autoriser les autres périphériques à utiliser ce service)
(sélectionné par défaut)
Cochez cette case pour autoriser les autres périphériques à se connecter pour transférer des objets PIM (voir
Fig. 42, « Onglet “PIM Objects” (Objets PIM) »). Si la case est désélectionnée, vous pouvez toujours vous

connecter à d’autres périphériques et leur envoyer des fichiers.

« Authorization required » (Autorisation requise) (sélectionné par défaut)
Cochez cette case si vous voulez filtrer les périphériques non liés avant
d’autoriser une transaction. Si elle est cochée, un message vous demande
d’accepter (Accept) ou de refuser (Reject) les transactions avec les
périphériques non liés (voir Fig. 40, « Boîte de dialogue “Authorization”
(Autorisation) »).

« Passkey is required » (Mot de passe requis) (désélectionné par défaut)
Cochez cette case afin de demander l’authentification pour le transfert des
objets PIM. Si elle n’est pas cochée, un message vous demande d’accepter
(Accept) ou de refuser (Reject) les transactions avec les périphériques non liés
(voir Fig. 41, « Demande de mot de passe »). Les périphériques non liés
devront fournir un mot de passe correspondant.Fig. 43 — Onglet « Serial Port » (Port série)
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« Encryption is required » (Cryptage requis)
Fonction activée uniquement lorsque vous cochez l’option « Passkey is required » (Mot de passe requis).
Cochez cette case pour activer le cryptage des données lors de la transmission des données.

« Send my business card on request » (Envoyer ma carte de visite sur demande)
Permet aux autres périphériques qui peuvent se connecter de « retirer » les informations de votre carte de
visite.

« Accept all PIM objects sent to me » (Accepter tous les objets PIM qui me sont envoyés)
Autorise les autres périphériques qui peuvent se connecter à vous envoyer des objets PIM.

« Use this contact for my business card » (Utiliser ce contact pour ma carte de visite)
Affiche le nom utilisé lorsque vous transférez une carte de visite à d’autres périphériques Bluetooth. Le bouton
« Browse » (Parcourir) vous permet de modifier les informations de la carte de visite en effectuant des
sélections dans la liste complète des contacts de votre base de données Outlook du PC de poche. Si un
contact Outlook n’est pas disponible, les données trouvées dans « My Information » (Informations
personnelles) du périphérique sont employées pour former les informations de contact. Si l’utilisateur
supprime l’entrée de contact, un message d’exécution apparaîtra la prochaine fois que vous essaierez
d’envoyer une carte de visite.

C O N F I G U R A T I O N  E T  P A R A M È T R E S  ( S U I T E )
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Onglet « Serial Port » (Port série)

« Let other devices use this service » (Autoriser les autres périphériques à utiliser ce service)
(sélectionné par défaut)
Cochez cette case pour permettre aux autres périphériques de se connecter via le port série. Si la case est
désélectionnée, vous pouvez toujours vous connecter (voir Fig. 43, « Onglet “Serial Port” (Port série) »).

« Authorization required » (Autorisation requise) (sélectionné par
défaut)
Cochez cette case si vous voulez filtrer les périphériques non liés avant d’autoriser
une connexion par le port série. Si elle est cochée, un message vous demande
d’accepter (Accept) ou de refuser (Reject) les transactions avec les périphériques
non liés (voir Fig. 40, « Boîte de dialogue “Authorization” (Autorisation) »).

« Passkey is required » (Mot de passe requis) (désélectionné par
défaut)
Cochez cette case pour exiger l’authentification pour la connexion par le port
série. Si elle n’est pas cochée, un message vous demande d’accepter (Accept)
ou de refuser (Reject) les transactions avec les périphériques non liés (voir
Fig. 41, « Demande de mot de passe »). Les périphériques non liés devront
fournir un mot de passe correspondant.

C O N F I G U R A T I O N  E T  P A R A M È T R E S  ( S U I T E )

Fig. 44 — Onglet « Dial-Up » (Accès à
distance)
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« Encryption is required » (Cryptage requis)
Fonction activée uniquement lorsque vous cochez l’option « Passkey is required » (Mot de passe requis).
Cochez cette case pour activer le cryptage des données lors de leur transmission.

Ports COM
Permettent d’identifier les ports COM (communication) virtuels associés à une connexion Bluetooth par le port
série. Le port « Inbound COM » (COM entrant) est utilisé lorsque d’autres
périphériques lancent une connexion série vers la carte adaptateur. Le port
« Outbound COM » (COM sortant) est utilisé lorsque vous lancez une connexion
série vers d’autres périphériques.

Onglet « Dial-Up » (Accès à distance (voir Fig. 44, « Onglet
“Dial-Up” (Accès à distance) »)

« Passkey is required » (Mot de passe requis) (désélectionné par
défaut)
Cochez cette case pour exiger l’authentification pour la connexion par accès
distant. Si elle n’est pas cochée, un message vous demande d’accepter (Accept)
ou de refuser (Reject) les transactions avec les périphériques non liés (voir
Fig. 41, « Demande de mot de passe »). Les périphériques non liés devront
fournir un mot de passe correspondant.

C O N F I G U R A T I O N  E T  P A R A M È T R E S  ( S U I T E )

Fig. 45 — Menu « Tools » (Outils)
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C O N F I G U R A T I O N  E T  P A R A M È T R E S  ( S U I T E )

« Encryption is required » (Cryptage requis)
Fonction activée uniquement lorsque vous cochez l’option « Passkey is required » (Mot de passe
requis). Cochez cette case pour activer le cryptage des données lors de la transmission des données.

« Using COM Port » (Utilisation du port COM)
Identifie le port BTC (communications Bluetooth) virtuel utilisé lorsque
vous lancez une connexion d’accès distant avec un autre périphérique.

Fig. 46 — Essai en boucle local
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Vous pouvez effectuer des vérifications élémentaires du matériel en utilisant soit un
« Loopback Test » (Essai en boucle) ou un « Reset BC01 Test » (Test de réinitialisation BC01).
Vous pouvez accéder aux deux à partir de l’écran « Diagnostics ».
« Loopback Test » (Essai en boucle)
Permet de tester la manière dont votre périphérique traite les données en interne. Si vous choisissez
d’exécuter l’essai en boucle ou tout autre test de diagnostic, le PC de poche effectue une réinitialisation
système.

1. Sélectionnez l’option « Diagnostics » du menu « Tools » au bas de la fenêtre
principale (voir Fig. 45, « Menu “Tools” (Outils) »).

2. Sélectionnez l’option « Local Loopback Test » (Essai en boucle local) du
menu déroulant et cliquez sur le bouton « Run » (Exécuter) (voir Fig. 46,
« Essai en boucle local »).

3. L’écran « Diagnostics » affiche le résultat du test : « Pass » (Réussite) ou
« Fail » (Échec).

D I A G N O S T I C  D U  S Y S T È M E

Fig. 47 — Test de réinitialisation BC01
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« Reset BC01 Test » (Test de réinitialisation BC01)
Permet de réinitialiser le circuit radio utilisé pour la transmission et la réception des données.

1. Sélectionnez l’option « Diagnostics » du menu « Tools » au bas de la fenêtre principale (voir Fig. 45,
« Menu “Tools” (Outils) »).

2. Sélectionnez l’option « Reset BC01 Test » (Test de réinitialisation BC01) du menu déroulant et cliquez sur
le bouton « Run » (Exécuter) (voir Fig. 47, « Test de réinitialisation BC01 »).

3. L’écran « Diagnostics » affiche le résultat du test : « Pass » (Réussite) ou
« Fail » (Échec).

Versions
Il est possible de consulter les informations sur la version du matériel, du
micrologiciel et du logiciel du périphérique en cliquant sur l’onglet
« Versions » de l’écran « Diagnostics ».

D I A G N O S T I C  D U  S Y S T È M E  ( S U I T E )
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D É S I N S T A L L A T I O N  D U  L O G I C I E L

Cette section contient des instructions pour désinstaller le logiciel nécessaire à l’utilisation de
la carte adaptateur.
1. Si elle est insérée, retirez la carte adaptateur de votre PC de poche.

2. Placez le PC de poche sur son support et établissez une connexion ActiveSync avec votre ordinateur de
bureau ou votre portable.

3. Insérez le CD d’installation de la carte adaptateur dans le lecteur de CD-ROM de votre ordinateur de
bureau ou de votre portable.

4. Dans le menu « Start » (Démarrer) du système Windows de l’ordinateur de base, sélectionnez « Run »
(Exécuter), puis entrez « X: Setup.exe » (où X correspond à la lettre du lecteur de CD-ROM) ou recherchez
le fichier « Setup.exe ». Cliquez sur « OK ».

5. Suivez les instructions qui apparaissent à l’écran. Lorsqu’un message vous demande si vous souhaitez que
l’assistant désinstalle le périphérique Bluetooth, cliquez sur « Yes » (Oui), puis sur « Next » (Suivant).

6. Suivez les instructions qui apparaissent à l’écran.
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D É P A N N A G E

L’application n’est pas installée correctement.
Assurez-vous d’avoir désinstallé tout logiciel Bluetooth existant. Si nécessaire, effectuez une réinitialisation
usine du PC de poche.

L’icône Radio Bluetooth n’apparaît pas dans l’écran « Today » (Aujourd’hui).
Assurez-vous d’avoir inséré correctement la carte adaptateur.

Impossible de trouver d’autres périphériques.
1. Rapprochez-vous d’un périphérique connu.

2. Vérifiez que votre radio est activée (voir l’icône Radio Bluetooth page 13). Vérifiez que vous n’avez pas
limité vos possibilités d’affichage des périphériques avec un filtre de recherche (voir « Bouton “Filter”
(Filtrer) » page 22).

La portée semble dégradée dans certains groupes.
Assurez-vous que vous n’avez pas limité la puissance de transmission (voir « Onglet “Connections”
(Connexions) » page 45).
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D É P A N N A G E  ( S U I T E )

Les autres périphériques ne parviennent pas à trouver le mien.
1. Rapprochez-vous d’un périphérique connu.

2. Vérifiez que votre radio est activée (voir l’icône Radio Bluetooth page 13).

3. Assurez-vous que vous n’avez pas limité la recherche des autres périphériques pour trouver le vôtre (voir
« Onglet “Connections” (Connexions) » page 45).

Les autres périphériques trouvent le mien, mais ils ne parviennent pas à s’y connecter.
Assurez-vous de ne pas avoir limité la connexion des autres périphériques (voir « Onglet “Connections”
(Connexions) », « Onglet “File Sharing” (Partage de fichiers) », « Onglet “PIM Objects” (Objets PIM) et
« Onglet “Serial Port” (Port série) » pages 45 à 51).

Les autres périphériques ne reçoivent pas les informations correctes de ma carte de visite.
Assurez-vous d’avoir correctement paramétré vos informations de carte de visite (voir « Onglet “PIM Objects”
(Objets PIM) » page 48).

J’ai enregistré des périphériques dans un groupe, mais je ne les trouve pas.
Vérifiez si le délai a expiré (voir « Onglet “General” (Général) » page 44).

Mon périphérique n’arrête pas automatiquement la recherche.
Vérifiez si vous avez sélectionné une période de recherche (voir « Bouton “Search” (Rechercher) » page 22).
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D É P A N N A G E  ( S U I T E )

Mon périphérique m’envoie toujours des message me demandant d’entrer un mot de passe.
Vérifiez les paramètres de mot de passe (voir « Onglet “File Sharing” (Partage de fichiers) », « Onglet “PIM
Objects” (Objets PIM) », « Onglet “Serial Port” (Port série) » et « Onglet “Dial-Up” (Accès à distance)
pages 46 à 52).

Mon périphérique ne m’autorise pas à supprimer le groupe « All Devices » (Tous les
périphériques).
Ce groupe ne peut être ni renommé, ni supprimé.

Je n’arrive pas à effectuer certaines transactions avec un périphérique alors que j’y parviens
avec d’autres.
Tous les périphériques n’offrent pas les mêmes profils Bluetooth.
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G L O S S A I R E

Authentification Fonction de sécurité qui exige de l’utilisateur qu’il entre un mot de passe
numérique avant de pouvoir échanger des données.

Autorisation Fonction de sécurité qui nécessite l’approbation de l’utilisateur avant qu’un
autre utilisateur ne puisse partager des données.

Bluetooth Neighborhood (Voisinage Bluetooth) Ensemble de périphériques Bluetooth.

Périphérique lié Reconnu par votre périphérique et ne nécessitant ni authentification ni
autorisation.

Périphérique Périphérique équipé de la technologie Bluetooth.

Adresse de périphérique Adresse électronique unique d’un périphérique Bluetooth.

Recherche de périphériques Recherche et reconnaissance d’un périphérique Bluetooth par un autre.

Groupe de périphériques Associations de plusieurs périphériques Bluetooth dans un groupe
généralement créé en fonction de tâches liées.

Nom du périphérique Nom fourni par un périphérique Bluetooth lorsqu’un autre périphérique
effectue une recherche.

Recherche de services Détermine les applications que d’autres périphériques ont en commun avec
vous.
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D É C L A R A T I O N  F C C / C E

DÉCLARATION DE CONFORMITÉ À LA RÉGLEMENTATION FCC
EN MATIÈRE DE COMPATIBILITÉ ÉLECTROMAGNÉTIQUE

Attention : Exposition aux radiations dues aux fréquences radio.
La puissance d’émission en sortie de cet appareil reste largement en dessous des limites d’exposition aux fréquences radios FCC. Toutefois, il est
conseillé d’utiliser l’appareil de manière à minimiser les risques d’exposition dans des conditions de fonctionnement normales.
Lorsqu’une antenne extérieure est raccordée à l’appareil, le placer de manière à minimiser les risques d’exposition dans des conditions de
fonctionnement normales. Pour éviter la possibilité d’excéder les limites d’exposition aux fréquences radio FCC, il est conseillé d’éviter qu’une
personne se trouve à moins de 20 cm de l’antenne dans des conditions de fonctionnement normales.

Avertissement de la Commission des Communications fédérale
L’appareil a été testé et satisfait aux limites de la classe B des appareils numériques, conformément à la partie 15 de la réglementation FCC. Ces
limites sont conçues de manière à assurer une protection raisonnable contre les interférences nuisibles au sein d’une installation domestique

Nous, Belkin Components, sis au 501 West Walnut Street , Compton CA, 90220, États-Unis, déclarons sous
notre seule responsabilité que le produit

F8T020
auquel se réfère la présente déclaration, est conforme aux normes énoncées à l’alinéa 15 de la réglementation
FCC. Le fonctionnement est assujetti aux deux conditions suivantes : (1) cet appareil ne peut pas provoquer
d’interférence nuisible et (2) cet appareil doit accepter toute interférence reçue, y compris des interférences
pouvant entraîner un fonctionnement non désiré.
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D É C L A R A T I O N  F C C / C E  ( S U I T E )

L’appareil génère, utilise et peut irradier une énergie radio fréquence. S’il n’est pas installé et utilisé conformément aux instructions, il peut
causer des interférences nuisibles sur le plan de la réception radio ou télévision, pouvant être déterminées en mettant l’appareil sous et hors
tension. L’utilisateur est invité à tester et à corriger l’interférence en prenant une des mesures suivantes :
• Réorienter ou changer de place l’antenne de réception.
• Augmenter la distance entre l’appareil et le récepteur.
• Connecter l’appareil à une prise située sur un circuit différent de celui sur lequel le récepteur est connecté.
• Consulter le revendeur ou un technicien en radio/TV pour obtenir de l’aide.

Modifications
La réglementation FCC souligne la nécessité d’indiquer à l’utilisateur que toute modification, de quelque nature que ce soit et non agréée par
Belkin Components, lui retire le droit d’utiliser l’appareil.

Canada-Industry Canada (IC)
La radio sans fil de cet appareil est conforme aux normes RSS 139 & RSS 210 Industry Canada. Cet appareil numérique de la classe B est
conforme à la norme ICES-003 du Canada.

Europe – Prescription Union européenne
Les produits radio portant le label CE 0359 ou CE alert satisfont à la directive R&TTE (1995/5/CE) établie par la Commission de la
Communauté européenne.
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D É C L A R A T I O N  F C C / C E  ( S U I T E )

L’accord avec cette directive implique la conformité aux normes européennes suivantes (le standard
international équivalent est indiqué entre parenthèses).
• EN 60950 (IEC60950) – Sécurité des produits
• EN 300 328 Conditions techniques exigées pour les appareils radio
• ETS 300 826 Conditions générales en matière de compatibilité électromagnétique pour les appareils radio.

Prière de consulter la plaque d’identification apposée sur votre produit Belkin pour déterminer le type d’émetteur.
Les produits portant le label CE satisfont à la directive relative à la compatibilité électromagnétique (89/336/EEC) et la
directive sur la basse tension (72/23/EEC) publiées par la Commission de la Communauté européenne. La conformité avec
ces normes implique la conformité avec les normes européennes suivantes (le standard international équivalent est
indiqué entre parenthèses).
• EN 55022 (CISPR 22) – Interférences électromagnétiques
• EN 55024 (IEC61000-4-2,3,4,5,6,8,11)- Immunité électromagnétique
• EN 61000-3-2 (IEC610000-3-2) - Émissions de courants harmoniques
• EN 61000-3-3 (IEC610000) – Fluctuations de tension et flicker
• EN 60950 (IEC60950) – Sécurité des produits
Les produits équipés de transmetteurs radio portent la marque CE 0359 ou CE alert et peuvent également afficher le logo CE.



63

G A R A N T I E

Garantie limitée d’un an du produit de Belkin Components
Belkin Components garantit ce produit contre tout défaut matériel ou de fabrication pendant toute sa période de garantie. Si l’appareil
s’avère défectueux, Belkin le réparera ou le remplacera gratuitement, à sa convenance, à condition que le produit soit retourné, port
payé, pendant la durée de la garantie, au dépositaire Belkin agréé auprès duquel le produit a été acheté. Une preuve d’achat peut être
exigée.

La présente garantie est caduque si le produit a été endommagé par accident, abus, usage impropre ou mauvaise application, si le
produit a été modifié sans autorisation écrite de Belkin, ou si un numéro de série Belkin a été supprimé ou rendu illisible.

LA GARANTIE ET LES VOIES DE RECOURS SUSMENTIONNÉES FONT FOI EXCLUSIVEMENT ET REMPLACENT TOUTES LES AUTRES,
ORALES OU ÉCRITES, EXPLICITES OU IMPLICITES. BELKIN REJETTE EXPRESSÉMENT TOUTES LES GARANTIES IMPLICITES, Y COMPRIS
MAIS SANS RESTRICTION, LES GARANTIES AFFÉRENTES À LA QUALITÉ LOYALE ET MARCHANDE ET À LA POSSIBILITÉ D’UTILISATION À
UNE FIN DONNÉE.

Aucun dépositaire, représentant ou employé de Belkin n’est habilité à apporter des modifications ou adjonctions à la présente garantie,
ni à la proroger.

BELKIN N’EST PAS RESPONSABLE DES DOMMAGES SPÉCIAUX, DIRECTS OU INDIRECTS, DÉCOULANT D’UNE RUPTURE DE GARANTIE,
OU EN VERTU DE TOUTE AUTRE THÉORIE JURIDIQUE, Y COMPRIS MAIS SANS RESTRICTION LES PERTES DE BÉNÉFICES, TEMPS
D’ARRÊT, FONDS DE COMMERCE, REPROGRAMMATION OU REPRODUCTION DE PROGRAMMES OU DE DONNÉES MÉMORISÉS OU
UTILISÉS AVEC DES PRODUITS BELKIN OU DOMMAGES CAUSÉS À CES PROGRAMMES OU À CES DONNÉES.

Certains pays ne permettent pas d’exclure ou de limiter les dommages accidentels ou consécutifs ou les exclusions de garanties
implicites, de sorte que les limitations d’exclusions ci-dessus ne s’appliquent pas dans votre cas. La garantie vous confère des droits
légaux spécifiques. Vous pouvez également bénéficier d’autres droits qui varient d’un pays à l’autre.
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